Obeying the rules

Over the centuries, typographic guidelines
have been developed to provide consistency
and competency within the profession,

to preserve the beauty and legibility of
typographic form, and to ensure that
typography functions as often mandated: to
clearly represent the thoughts of the author.

The guidelines presented...are not absolute
or definitive, but they are representatives

of a sturdy, time-tested collection of
typographic “rules.” They are presented here
to provide a context for informed typographic
exploration. In other words, rules must first
be understood before they can be broken.
Once it is known how to obey rules, one can
freely journey into unconventional terrain.

—Rob Carter

Working With Computer Type 4:
Experimental Typography

Rob Carter. 1997: RotoVision. p10.
(Digital Color & Type)

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule1

For optimum legibility, choose classical, time-tested
typefaces with a proven track record.

Well-seasoned typographic designers can usually count their
favorite typefaces on one hand. Most often, they are those
typefaces that are drawn and crafted with consistency among
characters, and those that exhibit highly legible proportions.

(text)

Baskerville
Bembo

Bodoni

Caslon

Centaur
Franklin Gothic
Frutiger

Futura
Garamond

Gill Sans

Goudy Old Style
Helvetica

News Gothic
Palatino
Perpetua

Sabon

Times New Roman
Univers

(available on McNeal macs)
Baskerville (ITC New Baskerville)

(Didot)

Adobe Caslon Pro
(Adobe Jenson Pro)
(News Gothic)

Futura

Adobe Garamond Pro

Gill Sans

Goudy Old Style (watch WS)
Helvetica Neue

News Gothic

Palatino

(Adobe Garamond Pro)
Times New Roman (“default”)
(Helvetica Neue)

(also appropriate)
Minion Pro
Myriad Pro (“default”)

favor originals over ‘knock-offs’
Helvetica (neue) over Arial
Palatino over Book Antiqua

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule2

Be mindful not to use too many different typefaces at
any one time.

The primary purpose for using more than one typeface is to
create emphasis or to separate one part of the text from another.
When too many different typefaces are used, the page becomes
a three-ring circus, and the reader is unable to determine what
is and what is not important.

(text)

The role of typographic experimentation is to extend the
bouwndawiesof language by freely probing visual and verbal
syntax and the relationships between word and image. Sy n -
tactic exploration enables designers to discover among
typographic media an enormous potential to edify, entertain,
and surprise. As in other forms of language typography is capa-
ble of ﬁofé es5L0L: The only limits to typographic
discovefy are thos¢/imposed by the designer herself.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule3

yes! same face:
contrast through
change of weight
and posture.

Avoid combining typefaces that are too similar in
appearance.

If the reason for combining typefaces is to create emphasis, it
is important to avoid the ambiguity caused by combining types
that are too similar in appearance. When this occurs, it usually
looks like a mistake, because not enough contrast exists be-
tween the typefaces.

(text)

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal syn-
tax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the bound-
aries of language by freely probing visual and verbal syntax and
the relationships between word and image. Syntactic exploration
enables designers to discover among typographic media an enor-
mous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal syn-
tax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the bound-
aries of language by freely probing visual and verbal syntax and
the relationships between word and image. Syntactic exploration
enables designers to discover among typographic media an enor-
mous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the boundaries of
language by freely probing visual and verbal syntax and the relation-
ships between word and image. Syntactic exploration enables de-
signers to discover among typographic media an enormous potential
to edify, entertain, and surprise.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule4

yes!

U&ic

Text set in all capital letters severely retards reading.
Use upper- and lower-case letters for optimum
readability.

Lower-case letters provide the necessary visual cues to make
text most readable. This is due to the presence of ascenders , de-
scenders, and the varied internal patterns of lower-case letters.
Using both upper- and lower-case letters is the most normative
means for setting text type, and a convention to which readers
are most accustomed. Upper-case letters can successfully be
used for display type, however.

distinct profile
UNIFORM PROFILE

THE ROLE OF TYPOGRAPHIC EXPERIMENTATION

IS TO EXTEND THE BOUNDARIES OF LANGUAGE BY
FREELY PROBING VISUAL AND VERBAL SYNTAX AND
THE RELATIONSHIPS BETWEEN WORD AND IMAGE.
SYNTACTIC EXPLORATION ENABLES DESIGNERS TO
DISCOVER AMONG TYPOGRAPHIC MEDIA AN ENOR-
MOUS POTENTIAL TO EDIFY, ENTERTAIN, AND SUR-
PRISE.

the role of typographic experimentation is to extend the bound-
aries of language by freely probing visual and verbal syntax and
the relationships between word and image. syntactic explora-
tion enables designers to discover among typographic media an
enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule5

For text type, use sizes that according to legibility
studies prove most readable.

These sizes generally range from 8 to 12 points (and all sizes in
between) for text that is read from an average distance of 12 to
14 inches. However, it is important to be aware of the fact that
typefaces of the same size may actually appear different in size
depending upon the x-height of the letters (the distance be-
tween the baseline and the meanline).

So, 8 point AGaramond or Jenson will be too small,
whereas 12 point Helvetica or Myriad will be too large.

8pt The role of typographic experimentation is to extend the

9pt The role of typographic experimentation is to extend the
10pt The role of typographic experimentation is to extend the
11pt The role of typographic experimentation is to extend the

12pt The role of typographic experimentation is to extend the

Adobe Garamond Pro The role of typographic experimentation is to extend the boundaries of lan-
10/12 guage by freely probing visual and verbal syntax and the relationships between
word and image. Syntactic exploration enables designers to discover among
typographic media an enormous potential to edify, entertain, and surprise.

Adobe Jenson Pro The role of typographic experimentation is to extend the boundaries of language
10/12 by freely probing visual and verbal syntax and the relationships between word
and image. Syntactic exploration enables designers to discover among typo-
graphic media an enormous potential to edify, entertain, and surprise.

Helvetica Neue 65 Medium The role of typographic experimentation is to extend the bound-
10/12 aries of language by freely probing visual and verbal syntax and
the relationships between word and image. Syntactic exploration
enables designers to discover among typographic media an enor-
mous potential to edify, entertain, and surprise.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule6

most restrained:
use of space only
to create hierarchy

no typographic contrast

2 levels of hierarchy:
display and text
definite, pronounced,
contrast

Avoid using too many different type sizes and weights
at the same time.

You only need to use as many different sizes and weights as
needed to establish a clear hierarchy of information. Josef
Miiller-Brockmann advocates using no more than two sizes,
one for display titles and one for text type. Restraint in the
number of sizes used leads to functional and attractive pages.

Type and experiment

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and ver-

bal syntax and the relationships between word and image.
Syntactic exploration enables designers to discover among
typographic media an enormous potential to edify, entertain,
and surprise.

Type and experiment

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and ver-

bal syntax and the relationships between word and image.
Syntactic exploration enables designers to discover among
typographic media an enormous potential to edify, entertain,
and surprise.

Type and experiment

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image.
Syntactic exploration enables designers to discover among
typographic media an enormous potential to edify, entertain,
and surprise.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule?7

Helvetica Neue Ultra light

Gill Sans Extra Bold

Minion Pro Regular

Use text types of book weight.
Avoid typefaces appearing too heavy or too light.

The weight of typefaces is determined by the thicknesses of the
letter strokes. Text typefaces that are too light cannot easily be
distinguished from their backgrounds. In typefaces that are too
heavy, counterforms diminish in size, making them less legible.
Book weights strike a happy medium, and are ideal for text.

The role of typographic experimentation is to extend the bound-
aries of language by freely probing visual and verbal syntax and
the relationships between word and image. Syntactic explora-
tion enables designers to discover among typographic media
an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to
extend the boundaries of language by freely
probing visual and verbal syntax and the re-
lationships between word and image. Syntac-
tic exploration enables designers to discover
among typographic media an enormous po-
tential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule8

Eurostile Condensed

Eurostile Medium

Eurostile Extended 2

Minion Pro Regular
75% horizontal scale

Minion Pro Regular
125% horizontal scale

Use typefaces of medium width. Avoid typefaces that
appear extremely wide or narrow in width.

Distorting text to make letters wider or narrower by stretching
or squeezing them with a computer impedes the reading pro-
cess. The proportion of such letters are no longer familiar to us.
Well designed type families include condensed and extended
faces that fall within accepted proportional norms.

The role of typographic experimentation is to extend the bound-
aries of language by freely probing visual and verbal syntax and
the relationships between word and image. Syntactic explora-
tion enables designers to discover among typographic media an
enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend
the boundaries of language by freely probing visual
and verbal syntax and the relationships between word
and image. Syntactic exploration enables designers
to discover among typographic media an enormous
potential to edify, entertain, and surprise.

The role of typographic experimenta-
tion is to extend the boundaries of
language by freely probing visual and
verbal syntax and the relationships
between word and image. Syntactic
exploration enables designers to dis-
cover among typographic media an
enormous potential to edify, entertain,
and surprise.

The role of typographic experimentation is to extend the boundaries of language

by freely probing visual and verbal syntax and the relationships between word and
image. Syntactic exploration enables designers to discover among typographic media
an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to
extend the boundaries of language by freely prob-
ing visual and verbal syntax and the relationships
between word and image. Syntactic exploration
enables designers to discover among typographic
media an enormous potential to edify, entertain,
and surprise.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule9

normal:
good letter & word spacing

wide letter spacing
narrow word spacing

narrow letter spacing
wide word spacing

For text type, use consistent letter and word spacing
to produce an even, uninterrupted texture.

Letters should flow gracefully and naturally into words, and
words into lines. This means that word spacing should increase
proportionally as letter spacing increases.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to ex-
tend the boundaries of language by freely prob-
ing visual and verbal syntax and the relationships
between word and image. Syntactic exploration
enables designers to discover among typographic
media an enormous potential to edify, entertain,
and surprise.

The role of typographic experimentation is to extend the boundar-
ies of language by freely probing visual and verbal syntax and the
relationships between word and image. Syntactic exploration enables
designers to discover among typographic media an enormous poten-
tial to edify; entertain, and surprise.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule10

Use appropriate line lengths. Lines that are too short or
too long disrupt to reading process.

When lines of type are either too long or too short, the read-
ing process becomes tedious and wearisome. As the eye travels
along overly long lines, negotiating the next line becomes dif-
ficult. Reading overly short lines creates choppy eye movements
that tire and annoy the reader.

The role of typographic experimentation is to extend the boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic exploration enables designers to discover among ty-
pographic media an enormous potential to edify, entertain, and surprise. As in other forms of language typography
is capable of infinite expression. The only limits to typographic discovery are those imposed by the designer herself.

The role of typographic experimentation is to extend the boundaries of
language by freely probing visual and verbal syntax and the relation-
ships between word and image. Syntactic exploration enables design-
ers to discover among typographic media an enormous potential to

acceptable line length is
based on cpl/
—characters per line—

above: >75 too long
same line length, larger type
< 70cpl is okay

here:
too narrow, especially if
justified!

right:
smaller type, greater cpl
acceptable

ideal:

~45 cpl (justified columns)
up to 70-75cpl for single
column work (like a novel)

The role of
typographic
experimentation
is to extend the
boundaries of
language by freely
probing visual
and verbal syntax
and the relation-
ships between
word and image.
Syntactic explo-
ration enables
designers to
discover among
typographic
media an enor-
mous potential to
edify, entertain,
and surprise. As
in other forms of
language typog-
raphy is capable
of infinite

c experi-
ition is to
BCnd thebound-
aries of language
by freely probing
visual and verbal
syntax and the
relationships be-
tween word and
image. Syntactic
exploration en-
ables designers to
discover among
typographic me-
dia an enormous
potential to edify,
entertain,  and
surprise. As in
other forms of
language typog-
raphy is capable
of infinite expres-
sion. The only

The role of typographic experimentation is to
extend the boundaries of language by freely prob-
ing visual and verbal syntax and the relationships
between word and image. Syntactic exploration
enables designers to discover among typographic
media an enormous potential to edify, entertain,
and surprise. As in other forms of language typog-
raphy is capable of infinite expression. The only
limits to typographic discovery are those imposed
by the designer herself.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
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Rule11

12/13.5

12/14.5

12/16

x-height, optical size
influence line spacing
(leading) requirements.
compare:

Centaur 12/12
“set solid”

VS

Didot 12/12
(note crashing)

VS

Helvetica Neue 12/12

For text type, use line spacing that easily carries the
eye from one line to the next.

Lines of type with too little space between them slow the read-
ing process; the eye is forced to take in several lines at once. By
adding one to four points of space between lines of type—de-
pending on the specific nature of the typeface—readability can
be improved.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the boundar-
ies of language by freely probing visual and verbal syntax and the
relationships between word and image. Syntactic exploration enables
designers to discover among typographic media an enormous poten-
tial to edify, entertain, and surprise.

The role of lypographic experimentation is to extend
the boundaries of language by freely probing visual and
verbal syntax and the relationships between word and
image. Syntactic exploration enal[jles designers to dis-
cover among lypographic media an enormous potential
to edify, entertain, and surprise.

The role of typographic experimentation is to extend
the boundaries of language by freely probing visual
and verbal syntax and the relationships between word
and image. Syntactic exploration enables designers
to discover among typographic media an enormous
potential to edify, entertain, and surprise.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule11continued

SSS>5>>>

warning!

more on line spacing,
specific to assignment
Z.A1

6pt space between
paragraphs causes
mis-alignment of baselines

(more on line spacing, known as ‘leading.’

Digital typesetting applications (Quark, InDesign, Illustrator)
default to 120% “auto leading” (baseline to baseline).

This means that 10pt type will be set with baselines 12 points
apart (vertically); 12pt type at 14.4.

Auto lead settings are identified by parentheses around the
numbers (14.4 pt)

Always override the ‘auto’ setting by selecting or typing the
leading you want (even if it is the same amount) to ensure
consistent line spacing. Auto leading, because it ‘flexes’ with the
character, has the potential to vary.

InDesign treats leading as a character attribute, rather than
paragraph attribute. Therefore, to adjust leading of an entire
paragraph, you have to highlight the entire paragraph.

or, you can change the preferences:
InDesign>Preferences> Text (or Type) >
M Apply leading to entire paragraphs

With column work, baselines must align horizontally.

This limits ‘space before’ and ‘space after’ settings to multiples of
the leading

[he role of typographic The role of typographic

experimentation is to experimentation is to
extend the boundaries  extend the boundaries
of language by freely of language by freely
probing visual and ver- ~ probing visual and

bal syntax and the rela-  verbal syntax and the
tionships between word  relationships between
and image. Syntactic word and image.

exploration enables Syntactic exploration

designers to discover
among typographic
media an enormous
potential to edify, enter-
tain, and surprise.

enables designers to
discover among typo-
graphic media an enor-
mous potential to edity,
entertain, and surprise.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule12

FL/rr

FR/rl

justified

use care

NEVER use
‘force justify’

centered

For optimum readability, use a flush left, ragged right
type alignment.

Although in special situations, other methods of type alignment
(flush right, ragged left; centered, and justified) are acceptable,
the trade-off is always a loss—however slight—in readability.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the bound-
aries of language by freely probing visual and verbal syntax and
the relationships between word and image. Syntactic explora-
tion enables designers to discover among typographic media an
enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the bound-
aries of language by freely probing visual and verbal syntax
and the relationships between word and image. Syntactic ex-
ploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule13

Strive for consistent, rhythmic rags.

Avoid rags in which strange and awkward shapes are formed
as a result of line terminations Also avoid rags that produce a
repetitious and predictable pattern of line endings.

The purpose of effective rags is not only to achieve aesthetic
beauty. When rags consist of line endings that are carefully ar-
ticulated, rhythmic, and consistent, they enable readers to move
gently and effortlessly down a text column. Rags provide logical
points of departure from one line to the next.

The role of typographic experimenta-
tion is to extend the boundaries of
language by freely probing visual and
verbal syntax and the relationships
between word and image. Syntac-

tic exploration enables designers to
discover among typographic media an
enormous potential to edify, entertain,
and surprise

The role of typographic experi-
mentation is to extend the

boundaries of language by freely prob-
ing visual and verbal syntax and

the relationships between word and
image. Syntactic exploration enables
designers to discover among typo-
graphic media an enormous poten-
tial to edify, entertain, and surprise

The role of typographic experimentation is to ex-

tend the boundaries of language by freely

probing visual and verbal syntax and the relation-

ships between word and image. Syntactic

exploration enables designers to discover among typo-
graphic media an enormous potential to edify, entertain,
and surprise

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule14

standard typographic
indent is 1-2 ems

(An em is a horizontal dis-
tance equal to the point size
of the type)

avoid
‘amateur conventions’

of half-inch indent, and
indent of 1st |

extra (“white”) line

alternatives

Clearly indicate paragraph, but be careful not to upset
the integrity and visual consistency of the text.

The two most common means of indicating paragraphs are

by indenting or inserting additional (vertical) space between
paragraphs. It is not necessary to indent the first paragraph in a
column of text.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal syn-
tax and the relationships between word and image.

Syntactic exploration enables designers to discover among
typographic media an enormous potential to edify, entertain,
and surprise.

The role of typographic experimentation is to extend
the boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image.

Syntactic exploration enables designers to discover
among typographic media an enormous potential to edify, en-
tertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal syn-
tax and the relationships between word and image.

Syntactic exploration enables designers to discover among ty-
pographic media an enormous potential to edify, entertain, and
surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal syn-
tax and the relationships between word and image. f8 Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal syn-
tax and the relationships between word and image.

Syntactic exploration enables designers to
discover among typographic media an enormous potential to
edify, entertain, and surprise.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule15

solution : try adjusting rag,
or slight negative tracking
(-20, or 1/50th em)

Avoid widows and orphans whenever possible.
(or, more humanely, take care of them!)

A widow is a word or very short line at either the beginning
or the end of a paragraph. An orphan is a single syllable at the
end of a paragraph. (note: you will find quite a variety of defini-
tions of these terms) Both of these lonely conditions should be
avoided whenever possible, for they destroy the continuity of
text blocks, create spotty pages, and interfere with concentra-
tion in reading.

Whether a single word at the end of paragraph is objectionable
is dependent on context. In narrow columns, a multi-syllabic
word might be sufficient to hold its own line.

On the other hand, in a wide measure, two very short words
might not be enough.

The role of typographic experimentation is to extend
the boundaries of language by freely probing visual and
verbal syntax and the relationships between word and
image.

The role of typographic experimentation

is to extend the boundaries of language by
freely probing visual and verbal syntax and
the relationships between word and image
of it.

Syntactic exploration enables
designers to discover among
typographic media an enormous
potential to edify, entertain, and
surprisingly.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule16

italic

sans/bold

color

small caps

too much!

Emphasize elements within text with discretion and
without disturbing the flow of reading.

Never overdo it. Use minimum means for maximum results.
The ultimate purposes for emphasizing elements within text are
to clarify content and distinguish parts of information

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal syn-
tax and the relationships between WORD AND IMAGE. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between WOF dand image.
Syntactic exploration enables designers to discover among ty-
pographic media an enormous potential to edify, entertain, and
surprise.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule17

Eurostile Bold

Eurostile Bold
145% horizontal

Eurostile Bold Extended 2

Eurostile Bold Condensed

Eurostile Bold
55% horizontal

Always maintain the integrity of type. Avoid arbitrarily
stretching letters.

Well designed typefaces exhibit visual qualities that make them
readable. Letters are painstakingly designed with specific pro-
portional attributes in mind. Arbitrarily distorting them com-
promises their integrity.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]

presentation by CWaldron GD|UM 2005-2007



Rule18

Always align letters and words on the baseline.

Letters are designed to coexist side-by-side on an invisible base-
line. When they stray from this orientation, they appear to be
out of control, their readability greatly compromised.

— X N O ~+ un Q

—Q S5

idINDOVLS LON ‘INITISYE dILVLOYH V ONOTVY NNY ATNOHS IdALTVDIILYIA
vertical type should run along a rotated baseline, not stacked!

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
[Experimental Typography; ch1 pp10-21]
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Rule19

standard contrast
greatest legibility

black on red
much lower value contrast

N

insufficient value contrast

N

value contrast improves
legibility

high hue contrast (vibrates!)
close value

N

high hue contrast (vibrates!)
close value

N

When working with type and color, ensure that sufficient
contrast exists between type and its background.

Too little contrast in hue, value, or saturation, or a combination
of these factors, can result in type that is difficult, if not impos-
sible, to read.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
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Rule19continued

greater legibility
with contrast in

value

value

hue and value

value

black on
mid-value, high chroma
cyan

tint of cyan on
middle-value green

more on type and color.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal

syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic
exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.

The role of typographic experimentation is to extend the
boundaries of language by freely probing visual and verbal
syntax and the relationships between word and image. Syntactic

exploration enables designers to discover among typographic
media an enormous potential to edify, entertain, and surprise.
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Rule20*

Always use professional typesetting punctuation and
spacing standards.

Many well-known practices are rooted in the limitations of
typewriters and carried over into word processing and desk-
top publishing. Professional typesetting conventions use the
tull range of character sets and proportional spacing built into
digital type.

“serif face quotation marks”

“sans-serif face quotation marks”
Typographers’ Quotes .
"dumb/amateur/WP quotation marks"

"dumb/amateur/WP quotation marks"

€6 JJ G6 99 & M ik 7Y 66 I 66 99

« » 6 Y w1 W n o« » MM O n

Apostrophes Apostrophes v single quotes:
07 w207
no
N1 1%L,
InDesign > opt shift] opt] opt[ opt shift [
Type >
Insert Special Characters >
Quotation Mark > apostrophes indicate -missing characters
Single Right ... _possession
’60s
stop 'n’ go

Harry’s dog
'tis the season
’cause | said so

*beyond Carter : WALDRON RULES

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
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Rule20*continued

Primes

vertical primes

angled primes

Dashes

. ____________________________________________________________________________________________________|
Always use professional typesetting punctuation and

spacing standards.

On the other hand, do not use quotation marks for
inch/feet (degrees/seconds, etc) marks, which are properly
indicated with primes.

final design is a 20" x 14" spread (20" =1'8")

glyph palette, or CS3 update: Control ’ (~’) Control ” (~4+’)

final design is a 20" x 14" spread (20" =1’ 8")
Symbol font > glyph palette
Apple Symbols > glyph palette

-hyphens—em dashes-en dashes

hyphens connect split words and compound words
My mother-in-law came to dinner on Satur-
day evening and brought wine.

em dashes set off phrases —like a comma—to separate
stand-alone ideas, or parenthetical comments.

en dashes substitute the word ‘to’ or ‘through’ or ‘until’
to indicate a range:
this class meets  8:30-11:30

hyphen - (hyphen key, to the right of zero)
endash -  option -
emdash — Option shift - (“capital en!”)

you will find varied aesthetics of use (space around) —you may
need to kern one side of en dashes, depending on the numbers

*beyond Carter : WALDRON RULES

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
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Rule20*continued

Always use professional typesetting punctuation and
spacing standards.

a few more things...

word spaces Only use one space after a period

(the convention of a double space is a hold over from the
monospace limitation of typewriters.)

tabs, indents “The space bar is not a design tool.” —Ellen Lupton (p164)

All indents and tabulated spacing should be set with “Tabs’
(Layout > Tabs) and formatting 1 palette (or 4 style sheet)
— do not use the space bar (except for word spaces!)

Paragraph styles Use Paragraph Styles and Character Styles to ensure consistency
Character styles and make type selection changes efficiently.

*beyond Carter : WALDRON RULES

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)
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Rule20*continued

Hanging Punctuation

Optical Margin Alignment
InDesign :

Window

>type & tables

> story V]
<type size>

Always use professional typesetting punctuation and

spacing standards.

oh, and another thing...

'’60s
top ’'n’ go
arry’s dog
'tis the season
‘cause | said so

*beyond Carter : WALDRON RULES

What do you
think about
snow in April?

What do you

think about
snow in April?

That’s not nice

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)

[Experimental Typography; ch1 pp10-21]
presentation by CWaldron GD|UM 2005-2007



Rule20*continued

lllustrator :

Optical Margin Alignment
select type object 3
Type >

Optical Margin Alignment

Roman Hanging Punctuation
paragraph @
v'Roman Hanging Punctuation

spacing standards.

. ____________________________________________________________________________________________________|
Always use professional typesetting punctuation and

...more on optical alignment

“What do you think

of snow in April?”

What do you think of

snow in April?
#@*&?

That’s not very nice!
“That’s not very nice!”

none

“What do you think of

snow in April?”

What do you think of

snow in April?
#@*&?

That’s not very nice!
That’s not very nice!”

roman hanging punctuation

*beyond Carter : WALDRON RULES

“What do you think of

snow in April?”

What do you think of

snow in April?
#@*18&2

That’s not very nice!
“That’s not very nice!”

optical margin alignment

“What do you think of

snow in April?”

What do you think of

snow in April?
#@*18&2

That’s not very nice!

“That’s not very nice!”

optical margin alignment +
roman hanging punctuation

Rob Carter. Digital Color & Type ‘obeying the rules’ (ch6 pp148-161)

[Experimental Typography; ch1 pp10-21]
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Rule21* —well, a suggestion, really

In text settings, use text figures (or “proportional Old
style” figures) when available (open type, or OSfigures
included in Small Cap fonts).

Figure styles

tabular lining

O 1 2 3 4 5 6 7 8 9 O monospace, cap height

tabular old style

012 3 4 5 6 7 8 9 (@) monospace, U/lc

proportional lining

O 1 2 3 4 5 6 7 8 9 O proportional space, cap height

proportional old style 012 3 4 5 6 7 8 9 O proportional space,U/Ic

InDesign character palette (far right) v
Open Type > (bottom section)

Character Styles > Open Type Features > Figure Styles
Paragraph Styles > Open Type Features > Figure Styles

Open Type fonts feature 0 symbol in the font preview palette,
or the format is identified in
Font Book : Preview > Show Font Info (88 I)

llustrator Open Type palette
(behind character palette, or Window > Type > Open Type
Figure: <pull down menu>

*beyond Carter : WALDRON RULES
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